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INSTALACIJA 
 
 
 
Minimalna konfiguracija potrebna da bi se na računaru mogao instalirati operativni 

sistem Windows XP Professional je procesor P233MHz ili ekvivalentan, 64MB radne 
memorije i 1.5GB prostora na hard disku. Preporučeni hardverski zahtevi su procesor PII 
na 300MHz ili ekvivalentan, 128MB radne memorije i 2GB prostora na hard disku. 

Windows XP Professional podržava veliki broj uređaja. Spisak hardverskih uređaja, 
koji su testirani možete naći na adresi  www.microsoft.com/hcl . HCL znači hardware 
compatibility list. 

Sa operativnih sistema Win98, Win Me, Win NT3.51 ili WinNT4 i Win2000 
Professional moguće je izvršiti nadogradnju na WindowsXP Professional. Pogodnost kod 
ovakve instalacije je mogućnost deinstalacije i povratka na prethodni operativni sistem. 

Instalacija WindowsXP Professional-a na jednom računaru traje oko 30 minuta, a 
predstavlja problem ako je treba izvesti na velikom broju računara. U tom slučaju se 
koriste: 

• daljinska instalacija, 
• instalacija bez prisustva, 
• instalacija kloniranjem hard diska. 
• preinstalacija 

 
 

Daljinska instalacija 
 
Da bi se sprovela daljinska instalacija, tj. instalacija preko mreže potrebno je da u 

mreži bude aktivan RIS (Remote Installation Services) server na kome postoji \i386 
direktorijum (distribucioni direktorijum), a da bi pristup RIS serveru bio moguć mreža 
mora imati DHCP (Dynamic Host Configuration Protocol) server, DNS (Domain Name 
System) server i Active Directory. Klijent na kome se instalira mora posedovati PXE  
(Pre-Boot Execution Environment) mrežnu karticu. 

 
 

Instalacija bez prisustva 
 

U toku “obične” instalacije traži se unos određenih podataka: product key, ime 
računara, administratorska lozinka, naziv bar jednog korisničkog računa itd., a to zahteva 
prisustvo korisnika. Na instalacionom disku WindowsXP Professional-a postoji alat 
Setup Manager pomoću kojeg možemo kreirati odgovore (“answer file”), snimiti ih na 
disketu i oni će automatski biti iskorišćeni u toku instalacije.  

Pronađite na instalacionom CD-u, u direktorijumu \SUPPORT\TOOLS, fajl 
Deploy.cab. Iskopirajte ga na hard disk i kad ga raspakujete dobićete, između ostalog, 
izvršni fajl setupmgr.exe. Nakon pokretanja program će Vas voditi i zatražiti potrebne 
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odgovore. Na osnovu tih odgovora  Setup Manager  će napraviti tekstualni fajl 
unattended.txt, koji treba preimenovati u winnt.sif i kopirati na flopi. Disketu treba 
ubaciti u drajv u toku instalacije. Takozvani “answer file” koji je napravljen pomoću 
Setup Manager-a može se naravno kreirati ili naknadno editovati i pomoću bilo kog tekst 
editora. Pomoću njega se može ukazati na putanje dodatnih drajvera, koji mogu biti 
potrebni u toku instalacije itd...) 

Primer answer fajla: 
 
[Data] 
AutoPartition = 1 
MsDosInitiated = 0 
UnattendedInstall = Yes 
 
[Unattended] 
UnattendMode = FullUnattended 
OemSkipEula = Yes 
OemPreinstall = No 
 
[GuiUnattended] 
AdminPassword = * 
OEMSkipRegional = 1 
TimeZone = 85 
OemSkipWelcome = 1 
 
[UserData] 
FullName = USERNAME 
OrgName = MS 
ComputerName = COMPUTERNAME 
 
[Identification] 
JoinWorkgroup = WORKGROUP 
 
[Networking] 
InstallDefaultComponents = Yes 
 

Sve opcije i komande koje Vam mogu zatrebati za kreiranje answer fajla možete naći na 
Microsoft-ovom sajtu na kome postoji online verzija WindowsXP professional Resource 
Kit-a. 
 
 

Kloniranje diska 
 
 U preduzećima i školama obično imamo potrebu za većim brojem identičnih 
konfiguracija. Na jednom računaru možemo instalirati operativni sistem, aplikacije i 
uraditi sva podešavanja, a onda imidž tog diska iskopirati i na ostale. Ovo se, na primer, 
može uraditi pomoću programa Norton Ghost.  

Master konfiguracija se može pripremiti pomoću Windows-ovog alata Sysprep 
(takođe je sadržan u Deploy.cab fajlu). Sysprep sa master kopije skida podatke 
jedinstvene za pojedinačni kompjuter. (1.Pokrenite Sysprep, 2.U okviru za dijalog 
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Windows System Preparation Tool kliknite OK, 3.U novom okviru za dijalog kliknite 
taster Reseal, 4.Potvrdite trenutnu podešenost opcija). Disk je spreman za preslikavanje. 
Posle kopiranja i startovanja “iskopiranog” sistema automatski se pokreće Mini-Setup 
wizard, pomoću kojeg se do kraja konfiguriše novi sistem. U tom delu se može koristiti 
unapred pripremljeni “answer file”. Ovako instaliran sistem će tražiti aktivaciju, koja se 
obavlja telefonski (poziva se regionalni Microsoft-ov centar) najviše 30 dana od dana 
instaliranja. 
 
Napomena: Kada kupite novi računar pomoću alata ugrađenih u Windows možete sva 
podešavanja i dokumente prebaciti vrlo lako na novu konfiguraciju. To se radi pomoću 
alata File and Settings Transfer Wizard. (Start > AllPrograms > Accessories > 
SystemTools > File and SettingsTtransfer Wizard) 
 
 
 

Preinstalacija 
 
 Microsoft je izdao mnogim proizvođačima računara licencu da preinstaliraju 
operativni sistem na hard disko. Uz takve računare se ne dobija Windows XP instalacioni 
CD, već se sa skrivene particije može podići sistem i instalirati Windows XP.  
Preinstalacijom obično se instaliraju i neki uslužni programi za koje su proizvođači dobili 
licence. 
 
 

Podela hard diska na particije 
 
 

Pre instalacije treba odrediti kako će hard disk biti podeljen na particije i koji 
sistem fajlova će koristiti. Podela na particije se može uraditi u toku instalacije 
WindowsXP-a. 
 

Diskovi mogu biti: 
• dinamički i 
• osnovni.  

 

Dinamički diskovi 
 

Dinamički diskovi se koriste da bi se podaci skladištili na velikom broju diskova. 
WindowsXP podržava nekoliko dinamičkih konfiguracija diska: jednostavne (simple), 
višečlane (spanned), i trakaste (striped). Kod višečlanih jedan volumen se širi sa jednog 
na drugi disk, a maksimalno mogu da se koriste 32 diska. Podaci se upisuju redom – kad 
se jedan disk popuni prelazi se na drugi. Kod trakastih podaci se upisuju ”istovremeno” 
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na svim diskovima. Jednostavni disk (volumen sa tog diska) se može kasnije proširiti na 
više fizičkih diskova tako da dobijemo višečlanu konfiguraciju.  
 
 

Osnovni diskovi 
 

Obično se koristi osnovna konfiguracija diska. Kod osnovnih diskova jedan 
fizički drajv može imati najviše 4 particije (npr. 4 primarne ili 3 primarne i jednu 
proširenu, a na proširenoj može biti više logičkih particija). Termin particije se koristi 
kod osnovnih diskova a termin volumen kod dinamičkih. Osnovni diskovi mogu da se 
pretvore u dinamičke ali obratno ne može bez brisanja podataka. 

Po preporuci Microsoft-a treba odvojiti 2GB samo za operativni sistem. Kad se 
instalira Windows XP njegovi fajlovi se smestaju na dve lokacije: na sistemsku i na 
“boot” particiju. Sistemska particija sadrži fajlove potrebne za startovanje operativnog 
sistema (ntldr, boot.ini, ntdetect,...), dok se na boot particiji nalazi WINDOWS folder. 
Sistemska particija može biti samo jedna, a boot particija postoji za svaki operativni 
sistem, kod multi-boot sistema. Boot particija je, ustvari ta, koja treba da ima veličinu od 
bar 2GB. 
 
 

Izbor sistema fajlova 
 

Windows XP može da koristi tri sistema fajlova: FAT , FAT32 i NTFS. 
 
 FAT FAT32 NTFS 
Operativni sistemi DOS, Win3.x Win95, Win98, WinMe, 

Win2000, WinXP 
WinNT,Win2000, 
WinXP 

Veličina particije 2GB 2TB “neograničena” 
Prednosti Pogodan za diskove 

malog kapaciteta 
Dual boot -ako su 
instalirani Win98 i 
WinXP, oba sistema 
mogu da čitaju taj 
sistem fajlova 

Lokalna bezbednost 
fajlova i direktorijuma, 
Kompresija podataka, 
kvote, šifrovanje 
fajlova, dnevnik izmena 

 
Sistem izbora je svakako NTFS zbog razloga navedenih u tabeli. NTFS dobro štiti 

fajlove neophodne za rad sistema. Ako se neki fajl slučajno obriše vratiće ga prilikom 
sledećeg pokretanja sistema. Vodi se dnevnik izmena na osnovu koga sistem može da se 
vrati u prethodno stanje. Uvedena je lokalna bezbednost, pa se različitim grupama 
korisnika mogu dodeliti različita prava nad određenim fajlovima i direktorijumima. 
Dozvoljeno je šifrovanje fajlova. Moguća je kompresija radi uštede prostora na disku i 
moguće je korisnicima odrediti kvote – koliko prostora na disku može svaki od njih da 
koristi. 

U Windows XP-u je moguće particiju iz FAT32 sistema konvertovati u NTFS 
(obratno nije moguće bez prethodnog formatiranja). Konverzija FAT32 sistema u NTFS 
može da se izvrši na sledeći način. Prvo treba doći do komadne linije preko Start > 
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AllPrograms > Accessories > CommandPrompt ili preko Start > Run > (otkucajte) cmd > 
OK. Kad se pojavi CommandPrompt treba otkucati sledeću naredbu: 

 
CONVERT [driveletter]: /FS:NTFS 
 

Napomena: Bez obzira na pomenutu “otpornost” WindowsXP-a, dešava se da se neke 
ključne komponente Windows-a oštete. Ako posumnjate da se to desilo treba pokrenuti 
System File Checker (SFC) i on će sa instalacionog CD-a preuzeti oštećene ili 
nedostajuće fajlove. (Start>Run>upišite: sfc /scannow). Kod takvog korišćenja SFC-a 
postoji problem. Pri preuzimanju bilo kog fajla sa CD-a (a verovatno će ih biti više) traži 
se potvrda korisnika. Znači, potrebno je prisustvo korisnika, a proces skeniranja nije 
kratak. Ovaj problem se može rešiti tako što na hard disk, na primer na C:\, snimite 
distribucioni folder i386, koji se nalazi na Windows XP Professional instalacionom CD-u 
i napravite sledeću izmenu u Registry bazi. Idite na Start > Run > (upišite) regedit > 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\WindowsNT\CurrentVersion i u 
desnom oknu prozora videćete SourcePath. Desni klik, odaberite Properties i promenite 
vrednost na C: \ (ako ste distribucioni direktorijum snimili na C:\). 
 
Napomena: Chkdsk je alat koji treba povremeno pokrenuti. Služi da proveri postoje li 
greške na disku ili u fajl sistemu i može automatski da pokuša da oporavi loše sektore. 
Može se pokrenuti i preko Start > ControlPanel > AdministrativeTools > 
ComputerManagement > DiskManagement > (desni klik na particiju)Properties > Tools 
> CheckNow. 
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STARTOVANJE SISTEMA 
 
 

Sekvenca startovanja zove se startup sekvenca ili boot sekvenca. Odakle nazivi 
bootstrapping (bootstrap), ili kraće booting (boot)? Baron Minhauzen je tvrdio da je sebe 
izvukao iz blata tako što je snažno povlačio (samog sebe) za kosu. Druga verzija ove 
priče glasi da je izvukao sebe iz mora vukući za kaiševe svojih čizama. Kako operativni 
sistem startuje sa radom? – Učitavajući samog sebe. Ne baš. U računarstvu se termin 
booting koristi kad jednostavan sistem aktivira komplikovaniji sistem.  

 
 

Startup sekvenca za WindowsXP (za x86 sisteme) 
 
 

Svaki PC ima malu količinu CMOS (complementary metal oxide semiconductor 
izgovara se see-mos) memorije, koja se napaja baterijom. Ova memorija, za vreme dok je 
računar isključen, pamti datum, vreme i sistemske parametre kao npr. redosled butabilnih 
uredjaja, frekvenciju magistrale itd... BIOS (Basic Input Output System) čip snabdeva 
procesor instrukcijama prilikom uključenja racunara – pre nego se učita operativni 
sistem. BIOS je program, a ne uređaj (procesor izvršava instrukcije), a u CMOS-u su 
pohranjena podešavanja. BIOS je  nalik preoperativnom sistemu. 
 

Pre-boot sekvenca 
 

Prvo što procesor uradi nakon uključenja je POST (Power On Self Test) rutina, na 
osnovu instrukcija koje dobija od BIOS-a. POST je rutina koja proverava da li je pri 
uključenju «sve na broju» (misli se na neophodne komponente kao što su memorija, 
grafički adapter itd...). 

Na osnovu podataka pohranjenih u CMOS-u zna se redosled butabilnih uređaja. 
Obično je na prvom mestu floppy, sledi CD-ROM, pa tek onda HDD (Hard Disk Drive), 
ali se najčešće butovanje odvija sa hard diska. Sa hard diska se prvo čita MBR (Master 
Boot Record) koji se nalazi se na početku prvog sektora i sastoji se od boot koda i boot 
tabele. Na osnovu boot tabele se zna koja je aktivna particija. 

 

Boot-sekvenca 
 

 Prvi sektor aktivne particije sadrži boot kod koji omogućuje da računar locira i 
pokrene Ntldr - program koji kasnije bira i pokreće operativni sistem. Kad je uspešno 
lociran i pokrenut Ntldr, BIOS mu prepušta kontrolu. Ntldr učitava startne fajlove sa boot 
particije i iz real-moda (u kojem se koriski samo 640kB) prelazi u 32-bitni mod čime 
omogućava procesoru da koristi veću količinu memorije (2GB). Ntldr dalje obrađuje 
Boot.ini fajl da bi odabrao boot particiju operativnog sistema. Ako se odabere WinXP, 
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WinNT ili Win2000, Ntldr nastavlja sa fazom detekcije hardvera. Ako se odabere Win98, 
Win95, WinMe ili MS-DOS tada Ntldr prepušta kontrolu Bootsect.dos fajlu, čitajući 
MBR koji Bootsect.dos sadrži, kao da je taj MBR pročitan sa početnog sektora diska. 
Pretpostavimo da je izabran Windows XP, onda će Ntldr pokrenuti Ntdetect.com - 
program koji sprovodi osnovnu detekciju hardvera. Ntldr sakuplja informacije o tipu 
hardvera i uređajima (datum i vreme, tipovi magistrala i adaptera, video adapter, 
tastatura, komunikacioni portovi, diskovi, flopi diskovi, miš, paralelni portovi, uređaji na 
ISA magistrali). Ntdetect.com informacije o hardveru prosledjuje Ntldr-u. Nakon 
detekcije hardvera, Ntldr vrši izbor hardverske konfiguracije tj. hardverskog profila 
(prenosivi računari mogu imati dva profila docked i undocked, kod desktop računara 
postoji samo jedan i taj se učitava automatski).  
 
Usput: Pogledajte Boot.ini fajl Vašeg Windows XP-a na sledeći način. Idite na Start > 
ControlPanel > System > Advanced > Sartup and Recovery (Settings) > System Startup 
(Edit) i videćete kako izgleda Boot.ini fajl, koji se tu može i editovati. Na primer, možete 
dodati  svič /bootlog (u donjem tekstu vidite gde sam ja to uradio na računaru na kojem 
pišem ovaj tekst) i tokom startup-a Windows će voditi dnevnik dešavanja i snimiti ga u 
C:\WINDOWS\ntbtlog.txt. 

 
[boot loader] 
timeout=3 
default=multi(0)disk(0)rdisk(0)partition(2)\WINDOWS 
[operating systems] 
multi(0)disk(0)rdisk(0)partition(2)\WINDOWS="MicrosoftWindowsXPProfessional"/fa
stdetect/NoExecute=OptIn /bootlog 
C:\CMDCONS\BOOTSECT.DAT="Microsoft Windows Recovery Console" /cmdcons  
 

Sekvenca učitavanja Kernel-a 
 

Ntldr dalje učitava Kernel (Ntoskrnl.exe) i HAL (hal.dll) ali ih još uvek ne 
startuje. HAL (Hardware Abstraction Layer) služi da spreči programe (drajvere) da 
direktno pristupaju hardveru. (Ovo je razlog zašto mnogi DOS programi ne mogu da rade 
pod WindowsXP-om) 

Registry baza je baza podataka svih podešavanja potrebnih za pokretanje 
Windows-a i programa koji su instalirani. Ntldr iz Registry baze čita  ControlSet - skup 
podataka o drajverima i servisima. Taj skup podataka se nalazi u  
HKEY_LOCAL_MACHINES\SYSTEM\CurrentControlSet\. Ntldr učitava drajvere sa 
startnom vrednošću 0, takozvane low-level drajvere, kao na primer drajver za hard disk 
kontroler. Low-level drajveri mogu direktno pristupati hardveru. Nakon njihovog 
učitavanja Ntldr prepušta kontrolu Kernel-u (Ntoskrnl.exe). 
 

Sekvenca inicijalizacije Kernela 
 

Početak ove sekvence praćen je prikazivanjem Windows XP logoa na ekranu. 
Ntoskrnl.exe upisuje Hardware Key u Registry bazu. Hardware Key se upisuje u 
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HKEY_LOCAL_MACHINE\HARDWARE. Ntoskrnl.exe kreira Clone Control Set, 
identičan onom koji je učitao Ntldr, a koji se koristi kasnije u boot procesu. Ntoskrnl 
inicijalizuje low-level drajvere, koje je ranije učitao Ntldr, pretražuje  
HKEY_LOCAL_MACHINES\SYSTEM\CurrentControlSet\Services u potrazi za 
drajverima i servisima sa startnom vrednošću  1 (npr.mrežni protokoli) i inicijalizuje ih 
čim ih učita. Ako pritom dođe do greške startup može da se nastavi bez ikakvog 
upozorenja ili u najgorem slučaju da se potpuno prekine.  

Pokreće se Session Manager (Smss.exe), koji prebacuje Windows iz tekst moda u 
grafički mod,  pokreće Logon Manager i kreira dodatnu virtuelnu memoriju (paging 
files). Session Manager na osnovu podataka iz Registry-ja izvršava komande koje se 
moraju pokrenuti pre startovanja servisa. Na primer, ako se detektuje problem u fajl 
sistemu, koji zahteva popravku pre završetka procesa butovanja, Session Manager će 
pokrenuti Autochk.exe.  
 

Sekvenca logovanja 
 

Windows podsistem pokreće Winlogon.exe. Winlogon pokreće Service Control 
Manager (Services.exe) i startuje Local Security Authority (Lssas.exe). GINA (Graphic 
Identification and Authrntication) komponenta sakuplja korisničko ime i lozinku. 

Sada se na osnovu Clone Control Set-a ažurira Control Set i ažurira se Last 
Known Good configuration i  «stupa na snagu» Group Policy settings. 

 Pokreću se Startup programi. Podaci o njima nalaze na sledećim lokacijama i  u 
sledećim ključevima registra: 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Runonce,  
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\policies\Explorer\Run, 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run, 
HKEY_CURRENT_USER\Software\Microsoft\Windows NT\CurrentVersion\Windows\Run, 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Run, 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\RunOnce, 
systemdrive\Documents and Settings\All Users\Start Menu\Programs\Startup, 
systemdrive\Documents and Settings\username\Start Menu\Programs\Startup. 
 Startup proces je završen tek nakon uspešnog logovanja. 
 
Napomena: Startup programe možete isključiti preko Start > Run > (otkucajte) msconfig 
i otvoriće se System Configuration Utility. Izaberite SelectiveStartup, zatim Startup i 
deselektujte programe koje hoćete da isključite. Odaberite Apply i Close. Restartujte 
računar. Nakon restarta Sistem Configuration Utility otvara prozor u kome treba da 
čekirate Don’t show this message... i kliknite OK. Na ovaj način ne mogu se isključiti svi 
startup programi, jer neki konfiguracione podatke, umesto u Registry, smeštaju u Win.ini 
fajl. Oni se mogu zaustaviti tako što ćete u System Confirugation Utility odabrati Win.ini. 
Tu sada možete deselektovati određene programe. 
Startup programe možete sprečiti i samo u toku jedne sesije i to na sledeći način. Odmah 
nakon logovanja pritisnite Shift i držite sve dok se ne pojavi vaš desktop i dok kursor ne 
prestane da menja oblik. 
Startup servise možete isključiti ako deselektujete Process System.ini File i Load System 
Services. 
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Napomena:Kada na računaru postoji više naloga a Vi želite podrazumevano tj. 
automatski da se logujete na jedan od njih, bez unošenja lozinke, možete napraviti 
sledeće izmene u registru: 
Start>Run>regedit>OK i otvorićete Registry Editor  
Nađite sledeći ključ u registru 
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\WindowsNT\CurrentVersion\Winlogon i 
dobićete, između ostalog u desnom oknu prozora DefaultUserName, gde ćete posle 
dvoklika na taj unos, upisati svoje korisničko ime i kliknuti OK. Zatim dvoklik na 
DefaultPassword unos, unesite lozinku u value data box i kliknite OK. (Ako ne postoji unos 
DefaultPassword napravite ga: Edit>New>StringValue>otkucajte DefaultPassword kao value name i 
kliknite Enter>dvoklik na novostvoreni ključ i otkucajte vašu lozinku u Value Data box) Dvoklik na 
AutoAdminLogon>upišite 1 u Value Data box i kliknite OK (Ako ne postoji unos 
AutoAdminLogon napravite ga Edit>New>StringValue>otkucajte AutoAdminlogon kao value name i 
kliknite Enter>dvoklik na novostvoreni ključ i otkucajte 1 u Value Data box). Izađite iz Registry 
Editora. Posle restarta bićete ulogovani automatski. Ako želite da preskočite automatsko 
logovanje i da se ulogujete kao neki drugi korisnik za vreme restarta držite SHIFT. 
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REŠAVANJE „STARTUP“ PROBLEMA 
 
 
 

Iz prethodnog teksta se vidi da je proces startovanja sistema prilično komplikovan 
i  lako mogu nastati problemi, koji zahtevaju popravak sistema ili u krajnjem slučaju 
reinstalaciju Windows-a. Problemi u startovanju ili u radu Windows-a nastaju  obično 
zbog  instaliranja novih programa ili drajvera, instaliranja još jednog operativnog sistema, 
pojave loših sektora na disku ili usled virusa. Da bi se moglo intervenisati potrebno je da 
imate medije sa kojih se može «podići» sistem. Treba na vreme napraviti komplet za 
Automated System Recovery (flopi na kojem su snimljena sva bitna podešavanja sistema 
i medij sa backup fajlom) i u određenim vremenskim intervalima snimati rezervne kopije 
dokumenata ili možda kompletan imidž diska, ako imate dovoljno prostora za to.  

Od komercijalnih programa Partition Magic i Norton Ghost su od velike pomoći, 
a postoji i nekoliko besplatnih alata pomoću kojih se može kopirati disk ili podići sistem, 
kao što su DrvImagerXP ili PE Builder. 

Dalji tekst govori šta treba uraditi ako WindowsXP neće da se podigne. 
 

 

Last Known Good Configuration 
 

Pokušati povratak na Last Known Good Cofiguration (Nakon Power On self Test-a 
pritisnite F8 otvoriće se Windows Advanced Options Menu i u njemu izaberite Last 
Known Good Configuration) 

 

Safe Mode 
 
Pokušati startovanje u Safe Modu, pa onda u grafičkom okruženju otkloniti problem. 
Ponekad je dovoljno samo ući u Safe mode i nakom toga restartovati računar, a on će 
normalno startovati Windows. 

 

System Restore 
 

Iz Safe Moda se takođe može pokrenuti System Restore. System Restore vraća sistem 
u neko prethodno stanje koje je napravio korisnik ili neko od stanja koje redovno 
pravi sam sistem. Pritom dokumenti ostaju očuvani. System Restore bi trebalo da 
bude stalno uključen. Možete proveriti da li je uključen System Restore preko Start > 
ControlPanel > System > SystemRestore. Kad želite da vratite računar u prethodno 
stanje ili da napravite snimak trenutnog stanja idite na Start > AllPrograms > 
Accessories > SystemTools > SystemRestore. 
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Automated System Recovery 
 

U Windows XP Professional-u treba napraviti nakon svake uspešne izmene 
konfiguracije ASR (Automated System Recovery) disk. Ovaj disk i rezervna kopija 
sistema se koriste za restauriranje sistema nakon nepravilnosti koje se jave u radu sa 
hard diskom. Da bi pokrenuli Automated System Recovery Wizard idite na Start > 
AllPrograms > Accessories > SystemTools > Backup > AdvancedMode > Next > 
Finish. Ponuđena lokacija za Backup fajl je A:\Backup.bkf što je loš izbor, jer taj fajl 
nikako neće moći da stane na flopi disk. Bekap se takođe ne može snimiti ni na CD ili 
DVD, tako da jedini izbor ostaje hard disk (najbolje eksterni, ali može da posluži i 
druga particija). Ne sme se backup fajl snimiti na sistemsku particiju, jer sa nje ne 
može da se iskoristi (kad se radi restauriranje sistemska particija se formatira). Na 
kraju će Automated System Recovery Preparation Wizard zatražiti i flopi disk, bez 
kojeg kasnija resturacija neće biti moguća, jer na njega snima sve bitne podatke o 
sistemu. Microsoft preporučuje da se ASR koristi kao poslednja opcija. Komplet za 
ASR se koristi na sledeći način: sistem se startuje sa Windows CD-a, tokom 
tekstualnog dela Setup-a pritisne se F2,  ubaci se ASR disk i prate se instrukcije. 

 

Recovery Console 
 

Recovery Console je alat koji se koristi sa komandne linije i služi za pokretanje i 
zaustavljanje usluga, formatiranje diskova i popravku sistema. Da bi ste ga koristili 
morate se prijaviti kao administrator (znati administratorsku lozinku). Recovery 
Console može da se pokrene sa instalacionog CD-a, ali može i da se instalira tako da 
bude dostupan prilikom svakog startup-a, čak i ako nemate pri ruci instalacioni CD. 
Sa CD-a se Recovery Console alat pokreće tako što startujete sistem sa CD-a i 
pritisnete «R», prvi put kad Windows Setup dozvoli korisniku mogućnost izbora 
(prikazano na slici).  
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Nakon toga Setup će tražiti da unesete broj instalacije Windowsa sa kojom ćete raditi, 
a spisak raspoloživih instalacija će biti izlistan na ekranu. Zatim se mora uneti 
administratorska lozinka, i to ne bilo koja, već lozinka za ugrađeni administratorski 
nalog. Dobićete odzivnik C:\WINDOWS> i za spisak raspoloživih komandi možete 
ukucati HELP. 
 
Ako u komandnoj liniji otkucate   
[driveletter]:\i386\Winnt32.exe /cmdcons , 
 dok se u odgovarajućem uređaju nalazi instalacioni CD, omogućićete korišćenje 
Recovery Console sa hard diska. Ovaj alat će u boot meniju biti prikazan kao dodatna 
stavka. 

 
Napomena: Administratorska lozinka je često prazna lozinka (što je veoma loša 
praksa) i obično je dovoljno pritisnuti Enter, ali ako niste sigurni da je zaista tako 
postavite novu pre nego što Vam zatreba. Novu lozinku možete postaviti preko Start > 
ControlPanel >AdministrativeTools > ComputerManagement > Local Users and 
Groups > Users, pa desni klik na Usera čiji opis glasi Built-in account for 
administering computer/domain. Idite na SetPassword > Proceed... i ukucajte novu 
lozinku. Naravno ovu promenu lozinke možete izvršiti samo ako koristite 
administratorski nalog. 

  

Paralelna instalacija 
 

Na istom hard disku može ,istovremeno, postojati više instalacija WindowsXP-a, tako 
da možete na vreme napraviti rezervnu instalaciju. Ovo je korisno i kod isprobavanja 
različitih podešavanja sistema. Paralelna (rezervna) instalacija može poslužiti za 
spasavanje podataka ako instalacija koju redovno koristite ne može da se podigne. 
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PODEŠAVANJE WINDOWS XP PROFESSIONAL-a 

 
Taskbar i Start menu 
 
 
Taskbar i start meni mogu da se podešavaju na sledeći način: desnim klikom na taskbar > 
Properties > Taskbar and Start menu properties>…  
Start meni može imati dva različita izgleda: “običan” Start menu i Classical Start menu. 
 
Sadržaj taskbara može da se menja. Desni klik na taskbar > Toolbars, pa izberite šta će 
biti prikazano. Korisno je da bude uključen Quick Launch. Quick Launch između ostalog 
treba da prikaže Show Desktop ikonu. Kad se otvori više aplikacija pogodno je da se 
jednim klikom može doći do desktopa, a to se postiže ovom ikonicom. Ako se ikonica 
Show Desktop izgubi sa Quick Launch menija, može se vratiti na sledeći način: Otvorite 
Notepad i otkucajte ili iskopirajte sledeći skript. 
 
[Shell] 
Command=2 
IconFile=explorer.exe,3 
[Taskbar] 
Command=ToggleDesktop 
 
Snimite fajl kao “Show Desktop.scf” u neki direktorijum i u 
C:\DocumentsandSettings\username\Application Data\Microsoft\Internet Explorer\Quick 
Launch postavite shortcut koji ukazuje na lokaciju fajla “Show Desktop.scf” 
 
Desktop se može prikazati i istovremenim pritiskom na tastere Win+D. 
 
 

Control Panel 
 
 
Control Panel - kontrolna tabla u prevodu. Iz kontrol panela se mogu napraviti skoro sva 
podešavanja sistema. Ovde će biti navedeni samo neki primeri. Taskbar i Start meni su 
takođe dostupni i iz Control Panel-a 
 
System 
 

Dvoklikom na ovu ikonicu dobijamo pristup System Properties prozoru u kome 
dalje imamo tab-ove: General – ispisuje osnovne podatke o računaru, Computer 
Name – prikazuje ime, članstvo u domenu ili radnoj grupi, Hardware – 
omogućava instalaciju i rešavanje hardverskih problema, promenu ili povratak na 
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prethodne drajvere, kreiranje hardverskih profila, Advanced – podešavanje 
vizuelnih efekata, optimizacija performansi i izgleda desktopa, podešavanje 
virtuelne memorije, rukovanje korisničkim profilima, editovanje boot.ini fajla, 
postupak prilikom pada sistema, System Restore – uklučivanje monitoringa 
particija, da bi se na osnovu dnevnika izmena mogli vratiti na prethodno stanje 
sistema, Automatic Updates – podešavanje ili isključenje automatskog ažuriranja 
Windows-a, Remote – omogućavanje i podešavanje Remote desktop i Remote 
assistant sesija. 

 
User Accounts 
 

Kreiranje osnovih tipova korisničkih računa. (Administrator, User, Guest) 
 
Regional and Language settings 
 

Omogućava izbor formata prikaza datuma, vremena, valute, izbor jezika, kodnog 
rasporeda tastature… Napomena: Za svakog korisnika se posebno vrši 
podešavanje. 

 
Network Connections 
 

Kreiranje i podešavanje opcija za konekcije i mrežne adaptere. 
 
Display 
 

Podešavanje desktopa, pozadine, screen saver-a i podrška za više ekrana. 
 
 
Add and remove programs 
 

Ispravan način za instalaciju i brisanje programa. 
 
Administrative Tools 
 

Pristup upravljanju servisima, lokalnom bezbednošću, korisničkim računima 
(detaljno), upravljanje diskovima (promena slovne oznake, formatiranje, 
konverzija fajl sitema, defragmentacija,… ), pristup pomoćnom programu Event 
Viewer itd… 
Event Viewer prikazuje dnevnik događaja kao npr. uspešno ili neuspešno 
pokretanje aplikacija i servisa. Koristan je ako se često dešavaju padovi sistema ili 
stratup problemi, jer može da prikaže koji servisi ili aplikacije prave probleme. 
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Run 
 
 
Start>Run. Omogućava pokretanje programa unosom imena izvršnog fajla. 
 
Primeri: 
 
Start > Run > (unesite)regedit > klik na OK - tako dolazimo do Registry baze. 
Start > Run > mmc - otvara se nova upravljačka konzola (MMC znači Microsoft 
Menagement Console) 
Start > Run > cmd - dolazimo do komandne linije. 
Start > Run > winword.exe – startuje Word. 
 
 
 

MMC konzola 
 
 
Snap in-ovi su upravljačke komponte koje se mogu dodati u MMC. MMC je okvir za 
upravljačke aplikacije. Snimljene MMC konzole (fajlovi sa msc ekstenzijom) mogu se 
preneti na druge računare. Sistem administratori mogu napraviti alate za obavljanje 
pojedinih zadataka održavanja i podeliti ih svojim saradnicima. 
 
Start > Run > (upišite)mmc > OK > File > Add/RemoveSnap-in > Add > odaberite 
Snap-in, zatim Add > LocalComputer > Finish > File > SaveAs… 
Do tako napravljene konzole može se doći preko Start > AllPrograms > Administrative 
Tools > ime konzole 
Konzola se može snimiti na 4 načina (izabere se pre snimanja File>Options): 
 

Mod Opis 

Author mode Korisnici imaju pravo da dodaju ili uklanjaju snap-
inove 

User mode – full access Korisnik ima pun pristup ali ne može da menja 
snap-inove 

User mode – limited 
access multiple window 

Korisnik nema pun pristup. Može da pristupi samo 
onim delovima drveta konzole koji su bili vidljivi 
kad je konzola snimljena, mogu da otvaraju nove 
prozore, ali ne mogu da zatvore onaj koji je bio 
otvoren prilikom snimanja konzole 

User mode – limited 
access single window 

Korisnik nema pun pristup. Može da pristupi samo 
onim delovima drveta konzole koji su bili vidljivi 
kad je konzola snimljena, ne može da otvori nove 
prozore i ne može da zatvori postojeći. 
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Komandna linija  
 
 
Do komandne linije se stiže preko: Start > AllPrograms > Accessories > 
CommandPrompt. Otkucajte HELP, pritisnite Enter i dobićete spisak komandi. Bilo koju 
komandu da otkucate, bez odgovarajućih parametara, dobija se kratko objašnjenje i 
sintaksa komande. Spisak svih komandi sa objašnjenjima može se videti na adresi 
http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-
us/ntcmds_o.mspx 
 
 

Task Manager 
 
 
Pritiskom na Ctrl+Alt+Del otvara se Windows Task Manager. U njemu postoje četiri 
kartice. Application daje spisak otvorenih aplikacija, Processes spisak programa koji rade 
u pozadini, Performance prikazuje iskorišćenost procesora i  memorije, a Networking 
prikazuje korišćenje mrežnih konekcija. 

 
 

Korisnički računi i grupe 
 
 
U Windows XP Professional-u postoji nekoliko ugrađenih računa: Administrator, Guest, 
Initial User, Help Assistant (koristi se u kombinaciji sa Remote Desktop Help Assistance 
feature), Support_xxxxx (Microsoft ga koristi za potrebe servisa za pomoć i podršku). Za 
svaki kreirani korisnički račun, kreira se i SID – bezbednosni identifikator. Ako obrišete 
neki račun, pa kasnije kreirate drugi sa istim nazivom, njihove SID oznake će biti 
drugačije i to će naravno biti različiti računi. Korisnički profil sastoji se od korisnikovih 
dokumenata, podešavanja radnog okruženja, Favorities, Cookies, pošte… 
 
 
Grupe 
 
Radi lakše dodele prava korisnici se učlanjuju u grupe. Npr. ako više korisnika treba da 
ima ista prava, napravite grupu učlanite ih u nju i grupi dodelite određena prava. 
Kreiranje nove grupe: Start > ControlPanel > AdministrativeTools > 
ComputerManagement > LocalUsers and Groups > desni klik na Groups > NewGroup. 
Administratori i Power Useri mogu da kreiraju grupe. Administratori mogu da upravljaju 
svim grupama, a Power User-i samo grupama koje su sami kreirali. 
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Ugrađene grupe Opis 

Administrators 
Instalacija operativnog sistema i komponenti, 
update Windowsa, preuzimanje vlasništva nad 
objektima,… 

Backup Operators Bekap i restore bez obzira na dozvole kojima 
su zaštićeni ti fajlovi 

Guests 

Imaju zabranu pristupa dnevnicima aplikacija i 
sistema. Osim toga imaju ista prava kao i 
Users. Guest, koji je član grupe Guests, nije 
authenticated user.  

HelpServicesGroup Mogu da koriste pomoćne aplikacije za 
dijagnostiku problema  

NetworkConfigurationOperators Mogu da menjaju mrežnu konfiguraciju, npr. 
dodeljivanjem IP adresa 

PowerUsers 

Imaju prava manja od administratora, a veća 
od grupe Users. mogu da menjaju sistemsko 
vreme, da kreiraju korisničke račune i deljene 
direktorijume. Imaju pristup i ključu registra 
HKEY_LOCAL_MACHINE\Software, 
pristup direktorijumu Program files, 
%windir%, %windir%\System32 (za poslednja 
dva direktporijuma imaju Read-only pristup). 
Imaju dozvole za instaliranje većine aplikacija, 
ali neće uvek instalacija biti uspešna jer 
nemaju dozvolu za instaliranje servisa, pa ne 
mogu instalirati aplikacije koje imaju servise. 

Replicator Mogu da vrše replikaciju fajlova u domenu 
Remote Desktop Users Imalu dozvolu za udaljeno logovanje 
Users Imaju Read i Write dozvole za svoj profil. 
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Specijalne grupe 
 
Upotrebljava ih sam operativni sistem. Članstvo u ovim grupama stiče se automatski, ako 
su ispunjeni odgovarajući kriterijumi. Upravljanje specijanim grupama se ne može vršiti 
pomoćnim programom Local Users and Groups. 
 

Grupa Opis 

Creator-Owner Račun (user) koji je kreirao objekat ili 
preuzeo vlasništvo nad objektom. 

Creator 

Grupa koja je kreirala ili preuzela 
vlasništvo. Kad običan korisnik kreira 
objekat ili preuzme vlasništvo, postaje 
Creator-Owner. Kada član grupe 
administratora kreira objekat ili preuzme 
vlasništvo tada grupa administratora 
postaje Creator group. 

Everyone  
Interactive Svi koji resurse upotrebljavaju lokalno 

Network Svi koji resurse upotrebljavaju preko 
mreže 

Authenticated Users Svi koji su pristupili pomoću validnog 
imena i lozinke 

Anonymous Logon 
Svi koji ostvare pritsup pomoću 
specijalnih računa kreiranih za anonimni 
pristup 

Batch Korisnički računi za poslove grupne 
obrade podataka 

Dialup Korisnici koji su se na mrežu prijavili 
preko dialup konekcije 

Service Korisnici sa korisničkim računima, koji 
se koriste za izvršavanje servisa 

System Račun preko kojeg objektima pristupa 
sam operativni sistem 

Terminal Service User Prijavljeni preko Terminal Services 
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NTFS i Share dozvole 
 

NTFS dozvole (lokalne) 
 
NTFS dozvole su osobine (atributi) direktorijuma. Ima 13 dozvola i mogu se grupisati u 6 
osnovnih grupa. NTFS dozvole su povezane sa objektom i ne menjaju se ako se objekat 
preimenuje ili mu se promeni lokacija. U Windows XP-u podrazumevano se dozvole 
nasleđuju od roditeljskih direktorijuma. NTFS dozvole su kumulativne i zasnovane na 
članstvu u grupi, tj. ako je korisnik član više grupa sve dozvole mu se sabiraju. Ako je 
korisnik član više grupa i u nekoj grupi mu je uskraćena određena dozvola, onda će ta 
zabrana imati prioritet nad dozvolama koje su mu obezbeđene članstvom u drugim 
grupama. Ako se korisniku promeni članstvo u grupi «efekat će biti vidljiv» tek kod 
sledećeg logovanja.  
 

Standard Permission Groups (Windows 2000 and Windows NT 4.0 

SCM) 

Permission Components 

(Windows 2000 and Windows 

NT 4.0 SCM) 
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Traverse Folder / Execute File         

List Folder / Read Data        

Read Attributes        

Read Extended Attributes        

Create Files / Write Data           

Create Folders / Append Data          

Write Attributes          
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Write Extended Attributes          

Delete Subfolders and Files            

Delete       
 

  

Read Permissions       

Change Permissions         
 

 

Take Ownership            

 
List Folder Contents i Read and Execute imaju iste komponente, ali se razlikuju po 
načinu nasleđivanja. List Folder Contents se koristi samo za direktorijume i ne nasleđuju 
ga fajlovi u direktorijumu, a Read and Execute se odnosi i na direktorijume i na fajlove i 
nasleđivanje važi i za direktorijume i za fajlove. 
NTFS dozvole mogu da se postave samo ako je isključena opcija Use simple file 
sharing. U Windowsu XP je podrazumevano uključena opcija Simple File Sharing. 
Možete je isključiti preko: Start (desni klik) > Expore > Tools > Folder Options > View 
> deselektujte Use simple file sharing. Nakon isključenja opcije Use simple file sharing, 
pogledajte Properties za neki direktorijum i videćete još jednu karticu – Security. Ona 
služi za podešavanje NTFS dozvola.  
 
Napomene:  

• Uzmimo na primer da ste odredili NTFS dozvole za neke direktorijume, a nakon 
toga uključili opciju Use simple file sharing. Ponovnim isključivanjem opcije Use 
simple file sharing, NTFS dozvole neće biti poništene ili promenjene bez obzira 
što pri otvaranju prozora Folder Properties više nećete imati karticu Security.  

• Ako se fajl premešta iz jednog u drugi direktorijum zadržava svoje NTFS 
dozvole, a ako se kopira nasleđuje dozvole od direktorijuma u koji je kopiran. 

 
 
 

Share dozvole (mrežne) 
 
Napomena: Da bi ste mogli da delite resurse u mreži, morate prvo pokrenuti Network 
setup wizard i uključiti deljenje štampača i fajlova. (Start > AllPrograms  > Accessories > 
Communications > Network Setup Wizard) 
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Share dozvole se primenjuju samo kad se direktorijumu pristupa sa mreže. Do kartice 
Sharing, u kojoj se podešavaju share dozvole, dolazi se tako što kliknete desnim tasterom 
miša na direktorijum kome želite da dodelite dozvole, odaberete Properties i onda karticu 
Sharing. Ukoliko kartica Sharing ne postoji, morate prvo pokrenuti Network setup 
wizard.  Kartica Sharing može imati različit sadržaj zavisno od toga da li se koristi 
jednostavno deljenje fajlova (simple file sharing). U daljem tekstu opisane su ove dve 
varijante: 
 

 Use simple file sharing  (Recommended) 
 
U ovom slučaju punu kontrolu nad direktorijumom imaju Owner, System i 
Administrator. Ako se na kartici Sharing nekog direktorijuma odabere Make this folder 
private, onda će samo Owner i System imati punu kontrolu – tj. samo onaj ko je kreirao 
fajlove, jer je on vlasnik.  
Korisnik koji je kreirao fajlove ne mora uvek biti i njihov vlasnik, jer nakon kreiranja moguće je da neko 
drugi preuzme vlasništvo. Vlasnik objekta je ustvari onaj ko može da dodeljuje dozvole za određeni objekat. 
Administrator ima mogućnost da preuzme vlasništvo nad fajlovima, ali ga se kasnije ne može odreći i 
ponovo ga dodeliti korisniku. Posledica toga je da korisnik koji je limited user neće moći pristupiti 
direktorijumu nad kojim mu je oduzeto vlasništvo. Pretpostavljeno je da administrator ne zna korisnikovu 
lozinku. Kad bi je znao mogao bi da tog korisnika unapredi u administratora, da se uloguje pod njegovim 
imenom i preuzme ponovo vlasništvo nad fajlovima, u ime tog korisnika. 
Napomena: Vlasništvo se može preuzimati ali se ne može preneti. Kad bi bilo omogućeno da se vlasništvo 
prenosi postojala bi opasnost da se podmeću fajlovi drugim korisnicima. 
Opcija Make this folder private je aktivna samo za direktorijum sa imenom korisničkog 
profila koji je trenutno aktivan, kao i za sve njegove poddirektorijume. Ukoliko ne 
izaberete opciju Make this folder private, možete direktorijum deliti na mreži izborom 
opcije Share this folder on the network. U tom slučaju treba još da odredite da li ostali 
korisnici  na mreži mogu da menjaju Vaše fajlove. 
Korišćenjem Simple file sharing korisničkog interfejsa konfigurišu se i Share i NTFS 
dozvole za određene direktorijume i fajlove u njima. Pomoću Simple file sharing može se 
konfigurisati pet različitih nivoa pristupa fajlovima i deljenim fajlovima: 
 

Nivo pristupa Everyone 
(NTFS/File) Owner System Administrators Everyone 

(Share) 
My Documents 

(Private) 
Not 

accessible Full Control Full Control Not accessible Not accessible 

My Documents 
(Default) 

Not 
accessible Full Control Full Control Full Control Not accessible 

Fajlovi u deljenom 
direktorijumu 

dostupni lokalnim 
korisničkim 

nalozima 

Read Full Control Full Control Full Control Not accessible 

Deljeni fajlovi na 
mreži Read Full Control Full Control Full Control Read 

Deljeni fajlovi na 
mreži (Dozvoljeno 
korisnicima da sa 

mreže menjaju 
fajlove) 

Change Full Control Full Control Full Control Full Control 
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Ako je aktivirana opcija Simple file sharing svaki korisnik sa mreže pristupa deljenim 
fajlovima preko Guest naloga. Usled toga ne funkcioniše konektovanje na deljene 
dirktorijume preko administratorskih naloga kao npr. konektovanje na C$. Da bi se 
moglo pristupiti deljenim fajlovima sa mreže, firewall mora biti isključen. Ako se Guest 
nalog isključi koristeći Control Panel, to utiče samo na lokalne korisnike, a sam Guest 
nalog nije onemogućen. Ako se prilikom pristupa sa mreže pokaže poruka Access is 
denied, verovatno je onemogućen Guest nalog korišćenjem Computer managementa u 
Administrative Tools-u. 
 
 Use simple file sharing (Recommended) 
 
Ako se ne koristi jednostavno deljenje fajlova, na kartici Sharing možete odrediti da li će 
direktorijum biti deljen ili ne. Dalje možete odrediti koliki je broj korisnika, koji 
istovremeno mogu da pristupe direktorijumu. Ako se odlučite za maksimalan broj 
korisnika znajte da će to u Windows XP Professionalu biti deset, iako sistem ne daje 
informaciju o tome. Samo u ovom slučaju se mogu postavljati share dozvole.  
 
Osnovne share dozvole su Read, Change i Full Control. Deny dozvole su jače od Allow 
dozvola. Kod bekapa particije, share dozvole nisu uključene u bekap (za razku od NTFS 
dozvola). NTFS dozvole su «starije». Znači, ako su NTFS prava dobro konfigurisana, 
kod share dozvola bi se svima mogla dati potpuna kontrola. Preporučuje se, da se, u 
pogledu share dozvola, Full Control dodeli grupi Authenticated Users, a da se sve uredi 
pomoću NTFS dozvola. 
 
Na shared (zajedničke) direktorijume ne primenjuje se sistem nasleđivanja kao kod 
NTFS direktorijuma. Ako je neki direktorijum zajednički i svi poddirektorijumi su 
zajednički i taj status im se ne može promeniti. 
 
U Computer Managementu može se videti spisak deljenih direktorijuma. Oni koji imaju 
dolarski znak nisu vidljivi, ali im administratori mogu pristupiti sa mreže komandom 
NET USE x: \\imeracunara\imedirektorijuma$. Taj direktorijum će biti mapiran kao x: 
 
Pomoćni program Shared Folders služi za pregled korisnika konektovanih na Shared 
direktorijume. Daje sledeće podatke: ime korisnika, ip adresu kompjutera sa kojeg je 
ostvarena konekcija, operativni sistem, broj otvorenih fajlova, ukupno vreme trajanja 
konekcije. Pomoćni program Shared Folders se pokreće na sledeći način: Start > 
ControlPanel > AdministrativeTools > ComputerManagement > SharedFolders > 
Sessions . 
 
Pomoću Windows Explorera moguće je mapirati mrežni drajv tj. dati mu slovnu oznaku. 
Otvorite Windows Explorer i zatim sa menija Tools odaberite Map Network Drive. 
 
Da bi neki deljeni direktorijum sa Vaše lokalne mreže učinili dostupnim i kad niste 
konektovani na mrežu (tzv. offline pristup), on mora biti mapiran ili mora biti 
poddirektorijum nekog mapiranog direktorijuma. Kada se izabere opcija Make Available 
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Offline (prethodno kliknite na direktorijum desnim tasterom miša) pokrenuće se wizard 
koji Vas vodi kroz detaljnija podešavanja (na primer, kada se vrši sinhronizacija fajlova 
sa mrežnom verzijom i slično). Ako su deljeni fajlovi na Vašem računaru dostupni nekom 
drugom korisniku u mreži, u offline režimu, NTFS pravima takođe možete urediti šta 
korisnik sme da radi sa preuzetim fajlom. Pre nego što se koriste direktorijumi ili fajlovi 
u offline režimu mora se isključiti opcija Use FastUser Switching! To se radi na sledeći 
način: Control Panel > User Accounts > Change the way users log on or off > 
deslektujte Use FastUser Switching.  
 
Napomena:  
Pojedinačni fajlovi se mogu učiniti dostupnim offline i bez mapiranja direktorijuma u 
kome se nalaze: desni klik na fajl > Make Available Offline. 
 

 

Local Security Policy 
(lokalne sigurnosne polise) 

 
Do Local Security Policy može se doći preko Administrative Tools. U Local Security 
Policy imate mogućnost podešavanja opcija za: lozinke – koje zahteve treba da ispune u 
pogledu kompleksnosti, za zaključavanje računara usled neuspešnog logovanja, za 
inspekciju (auditing), za dodeljivanje prava korisnicima, za podešavanje sigurnosnih 
opcija koje se tiču lokalnih resursa a primenjuju se na sve korisnike (Security Options). 
Možete dozvoliti ili zabraniti enkripciju fajlova.  
 
Enkripcija je moguća ako koristite NFTS fajl sistem. Podrazumevano je enkripcija 
dozvoljena. Da biste je zabranili kliknite na Public Key Policy > Encrypting file system > 
(desni klik)Properties i deselektujte opciju Allow users to encrypting files using 
Encrypting File System.  
 
Kod inspekcije (auditing) možete, na primer, beležiti kada su se desila uspešna ili 
neuspešna logovanja, kada se pristupalo nekom objektu itd. Dnevnik tih dešavanja se 
može videti u Event Viewer-u. Podrazumevano su sve inspekcije isključene radi uštede 
prostora na hard disku.  
 
Pod User Rights Assignment, u desnom oknu prozora, nabrojana su sva prava i možete za 
svako korisničko pravo dodavati ili brisati grupe korisnika koje to pravo imaju. Kod 
sigurnosnih opcija možete, na primer, zabraniti instaliranje drajvera koji nisu provereni ili 
zabraniti instaliranje drajvera štampača, ili omogućiti da se prilikom gašenja briše 
virtuelna memorija itd…  
 
 
U Local Security Policy postoje i Software Restriction Policies, a trebate ih koristiti 
izuzetno pažljivo i prvo na testnom kompjuteru. Pomoću ovih polisa možete zabraniti 
pokretanje određenih programa ili izvršavanje određenog tipa fajlova ili zabraniti 
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pokretanje fajlova koji se nalaze u određenom direktorijumu. Na primer, može se 
zabraniti pokretanje e-mail atachmenta tako što ćete zabraniti pokretanje određenih vrsta 
fajlova iz direktorijuma u koji se snimaju atachment-i. To se može uraditi na sledeći 
način: Software Restriction Policies > desni klik na Aditional Rules > New Path Rule > 
izaberite direktorijum u kome se snimaju atachment-i. 
 
U Windowsu XP Professional moguće je nadgledati pristup određenim direktorijumima 
ili štampačima na sledeći način. Prvo se otvori dijalog Properties za određeni 
direktorijum ili štampač. Izaberite Security > Advanced > Auditing > Add (i dodajte 
korisnika ili grupu čije pristupanje želite da pratite). Nakon toga mora se i u Local 
Security Policy > Local Policies > Audit Policy izabrati da se nadgleda pristup objektima 
(Audit object access). U Event Viewer-u moći ćete  da pronađete kada je korisnik 
pristupao direktorijumu ili štampaču. 
 
Da bi proverili koja prava imaju korisnici možete se poslužiti alatom Whoami, koji se 
pokreće iz komandne linije, a instalira se sa Windows XP Professional CD-a, 
pokretanjem setup.exe fajla u direktorijumu Support/Tools. Pomoću ovog alata možete 
videti i pripadnost grupama korisnika kao i sigurnosni identfikator (SID). 
 
Postoji nekoliko sigurnosnih šablona koji se nalaze u Windows/security/templates. Ovi 
šabloni se mogu iskoristiti jednostavnim importovanjem dok je otvoren prozor Local 
Security Setings. Kliknite desnim tasterom miša na Security Settings pa Import Policy. 
 
Izrada (pregled) sigurnosnih šablona se radi preko MMC konzole dodavanjem Security 
Templates snap-ina. Nakon što ste dodali Security Templates snap-in, dvaput kliknite na 
njega i ispod će se pojaviti putanja na kojoj su šabloni. Desnim klikom na tu putanju i 
odaberite New Template. Kada odredite pravila idite na Save As. 
 
Provera sigurnosne konfiguracije u odnosu na neki unapred dati šablon može da se izvrši 
na sledeći način. Start > Run > mmc /s > OK > File > AddRemoveSnapIn > Add > 
SecurityConfigurationAndAnalysis > Add > Close > OK > desni klik na Security 
Configuration and Analysis (u desnom oknu Console Root prozora) > OpenDatabase 
(treba da napravimo bazu podataka sa sadašnjim postavkama, upišite novo ime) > Open 
> u novom prozoru označite željeni šablon i kliknite Open > desni klik na Security 
Configuration and Analysis (u levom oknu prozora)> Analyze Computer Now > 
odaberite putanju u kojoj će log biti sačuvan > OK. Sada možete otvarati stavke u 
desnom oknu Console Root prozora i pregledati rezultate poređenja. 
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Group Policy 

(grupne polise) 

 
 
Način da se naprave detaljnija i opširnija bezbednosna ograničenja nego što nudi Local 
Security Policy je da se koristi Group Policy (u domenskom okruženju) odnosno Local 
Computer Policy (za workgroup okruženje ili stand-alone računare). Do Local Computer 
Policy se dolazi, pomoću MMC konzole, na sledeći način. Start >Run >(kucajte)mmc > 
OK > File >Add/Remove Snap-in > Add > Group Policy Object Editor > Add > Finish 
> Close > OK. Na taj način smo u MMC konzolu dodali Local Computer Policy snap-in. 
Drugi način da se dođe do Local Computer Policy je preko Start > Run >gpedit.msc.  
 
Napomena:  
Group Policy Object može biti snimljen u Aktivni direktorijum ako ste u domenskoj mreži 
i tada će se sva podešavanja odnositi na grupe korisnika. Ako nemamo domensko 
okruženje postavke se odnose na lokalni računar – otud ime Local Computer Policy.  
 
MMC konzolu sa Local Computer Policy snimite pod nazivom LocalGroupPolicy. Moći 
ćete da je otvorite preko Start > AllPrograms > Administrative Tools > 
LocalGroupPolicy.msc. 
 
Navešću nekoliko primera podešavanja sistema koji se mogu napraviti iz ove konzole: 
 
1. U stablu pronađite ConsoleRoot\LocalComputerPolicy\UserConfiguration\ 
AdministrativeTemplates\ControlPanel. Tu možemo potpuno zabraniti otvaranje 
Control Panela ili samo pojedinih pomoćnih programa u Control Panelu…  
 
2. Možete isključiti Run koristeći sledeću putanju 
ConsoleRoot\LocalComputerPolicy\UserConfiguration\AdministrativeTemplates\StartMe
nu and Taskbar pa u desnom oknu prozora birajte Remove Run from Start Menu.  
 
3. Idite na  
ConsoleRoot\LocalComputerPolicy\UserConfiguration\AdministrativeTemplates\System 
pa možete sprečiti pristup komandnoj liniji ako u desnom oknu prozora odaberete 
Prevent access to the command prompt. 
 
4. Možete zabraniti korisnicima da menjaju Desktop Background: 
LocalComputerPolicy\UserConfiguration\AdministrativeTemplates\ControlPanel\Displa
y\PreventChangingWallpapers. Ovim ste zabranili da korisnici promene pozadinu 
koristeći Display Properties, ali to još uvek mogu pomoću desnog klika na sliku koju žele 
da postave kao pozadinu i birajući SetAsBackground. Da biste i to sprečili uradite 
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sledeće: 
Start>Run>gpedit.msc>UserConfiguration>AdministrativeTemplates>Desktop>Active
Desktop>ActiveDesktopWallpaper>Enabled, dalje izaberite ime za pozadinu npr. Bliss 
(default u Windows XP) ili putanju do pozadine koju želite. Kada jednom postavite 
željenu pozadinu ostali korisnici neće moći da je menjaju. 
 
 

Enkripcija fajlova 
 
 
U Windows XP Professionalu mogu se šifrovati fajlovi i to se radi na sledeći način. 
Nakon kreiranja fajla kliknite na njega desnim tasterom miša. Birajte Properties > 
General > Advanced i selektujte opciju Encrypt contents to secure data. Fajl je šifrovan a 
Windows ga označava zelenom bojom. Taj fajl može da otvori samo korisnik koji ga je 
kreirao. Operativni sistem mu je automatski dodelio sertifikat i privatni ključ, kojim 
korisnik otvara svoj fajl. Korisnik ne mora ništa da zna o tome. Privatni ključevi se 
čuvaju u korisničkom profilu i ukoliko dođe do oštećenja ili gubitka ključa, korisnik više 
neće moći da otvori  šifrovani fajl. 
 
Da bi ste videli spisak korisnika, koji su do sada šifrovali fajlove, možete pogledati spisak 
sertifikata. Prvo treba napraviti mmc konzolu  u koju ćete dodati Certificates snap-in. 
Otvorite Console Root  > Certificates-Current User > Trusted People > Certificates i u 
desnom oknu prozora videćete spisak sertifikata.  
 
Ukoliko ste šifrovali neki fajl, korisno bi bilo da svoj sertifikat zajedno sa privatnim 
ključem snimite na disketu ili CD i čuvate. To se radi na sledeći način: Start > Run > 
mmc > File > Add/Remove Snap-in > Add > Certificates > Add > (selektujte) My user 
account > Finish > Close > OK > otvorite Certificates – Current user u levom oknu 
prozora i Personal > Certificates. U desnom oknu prozora videćete sertifikat sa Vašim 
korisničkim imenom. Desni klik na Vaš sertifikat > All Tasks > Export i pokrenuće se 
Certificate Export Wizard. Odaberite da uz sertifikat bude izvezen i privatni ključ, zaštite 
ga lozinkom i odredite lokaciju na koju ćete ga izvesti. 
 
 U Windows XP Professional-u možete odrediti Data Recovery Agenta (DRA) – to je 
korisnik koji ima pravo da otvara sve šifrovane fajlove, koji su šifrovani nakon što je on 
dobio sertifikat. Data Recovery Agent postoji da bi pomogao korisnicima u slučaju da 
korisnici usled promena ili grešaka u operativnom sistemu izgube svoje ključeve. 
 
Prvo morate dodeliti sertifikat i ključ Data Recovery Agent-u. To se radi iz komandne 
linije pomoću komande  
cipher /r:[ime_fajla] 
Biće kreirana dva fajla sa ekstenzijama CER i PFX. Pre nego što budu kreirani morate 
odrediti i lozinku kojom će biti zaštićeni (slika) 
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C:\Documents and Settings\zarko>cipher /r:sertifikat
Please type in the password to protect your .PFX file: 
Please retype the password to confirm: 
 
 
Your .CER file was created successfully. 
Your .PFX file was created successfully. 
 

 
 
U primeru prikazanom na slici biće kreirani fajlovi sertifikat.cer i sertifikat.pfx u 
direktorijumu C:\Documents and Settings\zarko. 
 
Moraju se uvesti (import) sertifikat i ključ za Data Recovey Agent-a. 
Otvorite mmc konzolu. Dodajte u nju Certificates snap-in, idite na Personal, zatim 
desnim klikom na Certificates, odaberite All Tasks > Import, i pokrenuće se Certificate 
Import Wizard. Kliknite Next > Browse > pod Files of Tipe odaberite All Files i za File 
Name birajte fajl sa ekstenzijom pfx, koji je kreiran pomoću naredbe cipher /r  > Next > 
unesite lozinku >Next (selektovano je Place all certificates in the following store i 
navedeno Certificate store:Personal)> Finish. Time je završen import sertifikata i ključa 
za DRA. 
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KONFIGURISANJE MREŽNIH ADAPTERA ZA TCP/IP 
PROTOKOL 

 
 

TCP/IP protokol 
  
 
Najčešće korišćeni mrežni protokol je TCP/IP protokol (Transmission Control Protocol /  
Internet Protocol). Instaliranje TCP/IP protokola obavlja se automatski prilikom čiste 
instalacije Windows XP Professionala. TCP/IP je obavezan za ostvarivanje pristupa 
Internetu. 
 
TCP/IP protokol zahteva da postoje IP adresa i podmrežna maska (koja služi da odredi 
kojoj podmreži pripada neka IP adresa). Pored toga mogu se zadati i podrazumevana 
kapija i DNS server.  
 
Podrazumevana kapija (default gateway) služi kao prolaz do druge mreže. 
 
DNS (Domail Name System) serveri služe za prevođenje naziva hosta u IP adresu. Na 
primer naziv domena pretraživača Google-a je www.google.com, a do njega možemo 
doći ako znamo njegovu IP adresu 66.249.85.104 (tj. ako je zna naš računar). Ako DNS 
server, koji smo zadali, ne zna traženu adresu on će je zatražiti od sledećeg DNS servera 
itd.  
 
Napomena: 
Adresu nekog domena možete saznati ako znate njegov naziv i iskoristite ga u komandi 
tracert. U komandnoj liniji otkucajte tracert www.google.com 
i dobićete spisak svih hostova kroz koje „prolazite“ na putu do Google-a. 
 

IP adresa 
 
32-bitna adresa, odeljena tačkama na četiri osmobitne, odnosno četiri „okteta“. Postoje tri 
klase IP adresa A, B i C. 
 
A klasa  
 
Kod adresa A klase vrednost prvog okteta može biti 1-126 i on služi za adresiranje mreže, 
a ostala tri okteta služe za adresiranje host-ova. Postoji 126 mreža A klase od kojih u 
svakoj može maksimalno da se adresira 16777214 računara. 224-2=16777214.  
Na primer, ako je vrednost prvog okteta 126 (time je označena mreža), slobodna su još 
tri okteta za adresiranje računara, a 224 iznosi 16777216. Od tog broja treba još odbiti 
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dve adrese: 126.0.0.0 (adresa same mreže) i 126.255.255.255 (adresa koja služi za 
emitovanje).  
 
Napomena:  
16777214 je teoretski največi mogući broj hostova na mreži A klase. Za pretpostaviti je 
da je tako velika mreža podeljena na podmreže, a u tom slučaju se na svakoj podmreži 
„gube“ po dve adrese. 
 
Mrežna maska (subnet mask) za mrežu A klase je 255.0.0.0. Ako se mrežna maska napiše 
ispod IP adrese, onaj deo IP adrese koji se nalazi iznad 255-ice je fiksiran i služi za 
adresiranje mreže, a onaj deo koji je iznad nula služi za adresiranje računara. 
 
Napomena:  
Ovo je uprošćeno objašnjenje, moguće je tzv. podmrežavanje, pri kom se 32-bitna adresa 
deli proizvoljno na određen broj bita, koji adresira mrežu (ne mora biti deljiv sa 8) i 
ostatak, koji adresira hostove. Mrežna maska u tom slučaju sadrži i brojeve koji nisu 
jednaki 0 ili 255. 
 
B klasa 
 
Prvi oktet ima vrednosti između 128 i 191. Pored ovog, kod adresa B klase i drugi oktet 
služi za adresiranje mreže, pa imamo ukupno (191-127)*256=16384 mreže na kojima se 
maksimalno može adresirati 216-2=65534 hosta. Mrežna maska je 255.255.0.0. 
 
C klasa 
 
Prvi oktet ima vrednosti 192-223. Prva tri okteta služe za adresiranje mreža, a poslednji 
za adresiranje hostova. Imamo (223-191)*216=2097152 mreže sa po 28-2=254 hosta. 
Mrežna maska je 255.255.255.0. 
 
Napomena: 
Kod prvog okteta izostavljeni su broj 127 - koristi se za povratnu petlju (loopback) i 
brojevi 224-255, koji se koriste za multicasting (224-239) ili eksperimentalno (240-255).  
 
 

Privatne IP adrese 
 
Računari koji se nalaze u LAN  mreži moraju takođe imati IP adrese da bi međusobno 
komunicirali. IP adrese koje se ne pojavljuju na Internetu (privatne adrese), već su 
rezervisane za lokalne mreže i koriste se u velikom broju mreža su:  
 
10.0.0.0        -   10.255.255.255   
172.16.0.0      -   172.31.255.255   
192.168.0.0     -   192.168.255.255 
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Računari u lokalnoj mreži su sakriveni iza rutera koji ima adresu dobijenu od provajdera 
internet usluga (može biti statička – uvek ista ili dinamička – dodeljena na neki 
vremenski period ili do prekida veze). Hostovi u lokalnoj mreži se ne „vide“ na internetu. 
Ruteri koriste NAT (network address translation) filtritanje tako da svaki računar u 
lokalnoj mreži dobija odgovarajuće (tražene) pakete podataka sa Interneta ili neke druge 
mreže sa kojom ih ruter povezuje. 
 

 

Dinamičke adrese u lokalnoj mreži 
 
Računari u lokalnoj mreži mogu dobiti svoju IP adresu dinamički: 1) ako u mreži imamo 
DHCP (Dynamic Host Configuration Protocol) server i 2) ako u mreži nema DHCP 
servera, pomoću APIPA (Automatic Private IP Addressing) servisa, koji je ugrađen u 
Windows XP Professional. IP adresa dobijena pomoću APIPA-e biće oblika 169.254.0.0. 
Ako postoji DHCP server i želite da koristite dinamički dodeljene adrese u lokalnoj mreži 
idite na Start > Control Panel > Network Connections > desni klik na odgovarajuću LAN 
konekciju > Properties > Internet Protocol (TCP/IP) > Properties > selektujte Obtain an 
IP address automatically. Ako se koristi ICS (Internet Connection Sharing) server, koji je 
povezan sa Internetom, on preuzima ulogu DHCP servera i dobija adresu 192.168.0.1, a 
svi ostali računari iz lokalne mreže dobijaju adrese iz opsega 192.168.0.2 – 
192.168.0.254. 
 
 

Statičke adrese u lokalnoj mreži 
 
Adrese u lokalnoj mreži se mogu dodeliti tako da budu nepromenljive (statičke). Idite na 
Start > Control Panel > Network Connections > desni klik na odgovarajuću LAN 
konekciju > Properties > Internet Protocol (TCP/IP) > Properties > selektujte Use the 
following IP address. Treba da popunite polje za IP adresu. Ako izlazite na Internet preko 
deljene konekcije najbolje da koristite opseg 192.168.0.2 – 192.168.0.254, za subnet 
mask automatski će biti upisano 255.255.255.0, a za default gateway treba upisati adresu 
Vašeg  rutera ili ICS servera. Za DNS server treba upisati adresu Vašeg rutera ili ICS 
servera, a možete staviti i adrese DNS servera Vašeg provajdera, jer će Vaš ICS server ili 
ruter funcionisati kao DNS proxy i svakako „pitati“ DNS servere Vašeg provajdera da 
urade prevođenje traženog imena u IP adresu. 
 
Dodelu IP adrese treba da uradite za svaki mrežni adapter koji ćete koristiti. Osim toga 
računar treba učlaniti u odgovarajući radnu grupu pokretanjem Network Setup Wizard-a i 
dodeliti mu jedinstveno ime na lokalnoj mreži. Windows XP će Vas upozoriti ako ste 
duplirali adresu ili ime računara u lokalnoj mreži. 
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Ako ste postavili statičke adrese u lokalnoj mreži, pregled imena računara i odgovarajuće 
IP adrese treba uneti u hosts fajl koji se nalazi u C:\WINDOWS\System32\drivers\etc. 
Otvorite hosts pomoću Notepad-a. Prvo se unosi IP adresa, zatim napravite razmak 
pomoću Tab tastera i unesete celo ime računara. Šta se podrazumeva pod celim imenom? 
Ako koristite ICS onda Windows podrazumevano uzima za ime domena 
MSHOME.NET. Celo ime računara će biti IME.MSHOME.NET. Treba i u TCP/IP 
Properties napraviti izmenu. Na kartici General kliknite Advanced, zatim odaberite 
karticu DNS i pored DNS suffix for this connection upišite MSHOME.NET. 
Hosts fajl omogućava bržu rezoluciju imena unutar lokalne mreže. U hosts fajl se takođe 
radi brže rezolucije imena mogu uneti i adrese i imena računara kojima se pristupa na 
internetu. Hosts fajl treba menjati samo na ICS serveru! 
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Komande koje se koriste pri podešavanju lokalne 
mreže 

 
 
Daću primere - nekoliko korisnih komandi, koje se koriste prilikom podešavanja ili 
korišćenja lokalne mreže. 
 
ping 127.0.0.1 – radi povratnu petlju, odnosno proverava ispravnost mrežnog adaptera. 
 
ping 192.168.0.x – proverava kakva je veza do određenog hosta 
 
net view – daje spisak imena i opisa hostova 
 
nslookup imedomena – daje adrese DNS servera, npr: nslookup www.teamnet.co.yu daje 
adresu njihovog DNS servera 
 
ipconfig /all – daje IP adresu, podrazumevani prolaz, adrese DNS i DHCP servera, kao i 
fizičku (MAC) adresu mrežnog adaptera. MAC adresa je hardverska adresa (ne možete je 
promeniti i jedinstvena je za svaki adapter) i može se koristiti u sigurnosne svrhe, tako što 
ćete na ruteru zadati spisak MAC adresa koje mogu da pristupe mreži. 
 

 
 

 34 



Administracija WindowsXP Professional-a 
 

arp (address resolution protocol) – izlistava tabelu IP adresa i odgovarajućih MAC 
adresa (arp -a), dodaje statičke adrese adapterima (arp –s, dodela je „trajna“ - važi do 
restarta) ili ih briše iz tabele (arp -d) 
 
tracert (trace route) – prati rutu do odgovarajućeg servera. Može da posluži za otkrivanje 
uskih grla, jer daje vreme koje je potrebno za „prolaz“ kroz pojedinačne servere. 
 

 
 
net use x: \\imeracunara\imedirektorijuma$ - Taj direktorijum će biti mapiran kao x: . 
U Computer Managementu može se videti spisak deljenih direktorijuma. Oni koji imaju 
dolarski znak nisu vidljivi, ali im administratori mogu pristupiti sa mreže pomoću ove 
komande (da bi se ovako mapirao drajv nekog hosta u mreži morate znati korisničko ime 
i lozinku za taj računar). 
 
net send * tekst poruke – šalje tekstualnu poruku svim računarima u radnoj grupi (ako se 
umesto * otkuca ime nekog računara, onda se samo njemu šalje poruka). Da bi ova 
komanda funkcionisala potrebno je da bude pokrenut Messenger servis. Komanda net 
start daje spisak svih pokrenutih servisa. Ako među njima nije Messenger, možete ga 
startovati pomoću net start messenger u komandnoj liniji ili preko 
Administrative Tools > Services.  
 

 

 

 35



Administracija WindowsXP Professional-a 
 

 

 

DODATAK I: Spisak komandi alata Recovery Console 

 
Komanda Funkcija 

Attrib Menja atribute datoteke ili direktorijuma 
Batch Izvršava komande zadate pomoću tekstualne datoteke 

Bootcfg Skenira disk u potrazi za instalacijama Windowsa i dodaje ih u 
boot listu itd... 

Cd, ili chdir Pokazuje ime tekućeg direktorijuma ili menja tekući 
direktorijum. Pomoću cd.., prelazite u direktorijum višeg nivoa 

Chkdsk Pokreće program CheckDisk 
Cls Briše ekran 

Copy Kopira datoteke sa prenosnog medija u sistemske direktorijume 
na hard disku i ne prihvata džokerske znakove 

Del, ili delete Uklanja datoteke (ne prihvata *) 
Dir Sadržaj direktorijuma 

Disable Isključuje zadati servis ili drajver 
Enable Uključuje zadatu uslugu ili drajver 

Diskpart Pravi ili uklanja particije (zamena za FDISK) 
Extract Izdvaja kompresovane .cab datoteke sa instalacionog diska na 

hard disk 
Fixboot Upisuje novi boot sektor na sistemsku particiju 
Fixmbr Pravi novi MBR 
Format Formatira zadatu particiju 

Help Daje spisak komandi 
Listsvc Prikazuje sve usluge i drajvere koji se izvršavaju 

 u WindowsXP-u 
Logon Prijavljuje Vas na instalaciju WindowsXP-a 

Map Prikazuje oznake mapiranih uređaja 
Md, ili mkdir Pravi direktorijum 

More, type Prikazuje sadržaj tekstualne datoteke 
Net Mapira drajvove na mreži 

Rd, rmdir Uklanja direktorijum 
Rename, ili ren Menja ime datoteke 

Systemroot Tekući direktorijum pretvara u root za disk na koji ste prijavljeni 
 

Ako otkucate bilo koju od ovih komandi praćenu sa /?, dobićete kratko uputstvo o 
korišćenju komande. Alat Recovery Console može se instalirati sa instalacionog diska. 
Ubacite CD i kliknite Exit, kad se pojave opcije za instaliranje pritisnite Exit. Na 
komandnoj liniji (Start > Run) kucajte  D:\i386\winnt32.exe /cmdcons i pritisnite Enter 
(umesto D: kucaćete oznaku za vaš optički drajv). Windows će pitati da li želite da 
instalirate Recovery Console... 
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DODATAK II – Run komande 
 
 
 
 
Run Commands 
 
compmgmt.msc - Computer management 
devmgmt.msc - Device manager 
diskmgmt.msc - Disk management 
dfrg.msc - Disk defrag 
eventvwr.msc - Event viewer 
fsmgmt.msc - Shared folders 
gpedit.msc - Group policies 
lusrmgr.msc - Local users and groups 
perfmon.msc - Performance monitor 
rsop.msc - Resultant set of policies 
secpol.msc - Local security settings 
services.msc - Various Services 
msconfig - System Configuration Utility 
regedit - Registry Editor 
msinfo32 - System Information 
sysedit - System Edit 
win.ini - windows loading information(also system.ini) 
winver - Shows current version of windows 
mailto: - Opens default email client 
command - Opens command prompt 
 
 
 
 
Run Commands to access the control panel 
 
Add/Remove Programs control - appwiz.cpl 
Date/Time Properties control - timedate.cpl 
Display Properties control  - desk.cpl 
FindFast control - findfast.cpl 
Fonts Folder control - fonts 
Internet Properties control - inetcpl.cpl 
Keyboard Properties control - main.cpl keyboard 
Mouse Properties control - main.cpl 
Multimedia Properties control - mmsys.cpl 
Network Properties control - netcpl.cpl 
Password Properties control - password.cpl 
Printers Folder control - printers 
Sound Properties control - mmsys.cpl sounds 
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System Properties control - sysdm.cpl 
 

 

DODATAK III – prečice u Windows XP Professional-u 
 
 
 
ALT+- (ALT+hyphen) Displays the Multiple Document Interface (MDI) child window's System 
menu 
ALT+ENTER View properties for the selected item 
ALT+ESC Cycle through items in the order they were opened 
ALT+F4 Close the active item, or quit the active program 
ALT+SPACEBAR Display the System menu for the active window 
ALT+TAB Switch between open items 
ALT+Underlined letter Display the corresponding menu 
BACKSPACE View the folder one level up in My Computer or Windows Explorer 
CTRL+A Select all 
CTRL+B Bold 
CTRL+C Copy 
CTRL+I Italics 
CTRL+O Open an item 
CTRL+U Underline 
CTRL+V Paste 
CTRL+X Cut 
CTRL+Z Undo 
CTRL+F4 Close the active document 
CTRL while dragging Copy selected item 
CTRL+SHIFT while dragging Create shortcut to selected iteM 
CTRL+RIGHT ARROW Move the insertion point to the beginning of the next word 
CTRL+LEFT ARROW Move the insertion point to the beginning of the previous word 
CTRL+DOWN ARROW Move the insertion point to the beginning of the next paragraph 
CTRL+UP ARROW Move the insertion point to the beginning of the previous paragraph 
SHIFT+DELETE Delete selected item permanently without placing the item in the Recycle Bin 
ESC Cancel the current task 
F1 Displays Help 
F2 Rename selected item 
F3 Search for a file or folder 
F4 Display the Address bar list in My Computer or Windows Explorer 
F5 Refresh the active window 
F6 Cycle through screen elements in a window or on the desktop 
F10 Activate the menu bar in the active program 
SHIFT+F10 Display the shortcut menu for the selected item 
CTRL+ESC Display the Start menu 
SHIFT+CTRL+ESC Launches Task Manager 
SHIFT when you insert a CD Prevent the CD from automatically playing 
WIN Display or hide the Start menu 
WIN+BREAK Display the System Properties dialog box 
WIN+D Minimizes all Windows and shows the Desktop 
WIN+E Open Windows Explorer 
WIN+F Search for a file or folder 
WIN+F+CTRL Search for computers 
WIN+L Locks the desktop 
WIN+M Minimize or restore all windows 
WIN+R Open the Run dialog box 
WIN+TAB Switch between open items 
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DODATAK IV - Command prompt lista komandi 
 
ADDUSERS Add or list users to/from a CSV file 
ARP      Address Resolution Protocol 
ASSOC    Change file extension associations 
ASSOCIAT One step file association 
AT       Schedule a command to run at a later time 
ATTRIB   Change file attributes 
 
BROWSTAT Get domain, browser and PDC info 
 
CACLS    Change file permissions 
CALL     Call one batch program from another 
CD       Change Directory - move to a specific Folder 
CHANGE   Change Terminal Server Session properties 
CHKDSK   Check Disk - check and repair disk problems 
CHKNTFS  Check the NTFS file system 
CHOICE   Accept keyboard input to a batch file 
CIPHER   Encrypt or Decrypt files/folders 
CleanMgr Automated cleanup of Temp files, recycle bin 
CLEARMEM Clear memory leaks 
CLIP     Copy STDIN to the Windows clipboard. 
CLS      Clear the screen 
CLUSTER  Windows Clustering 
CMD      Start a new CMD shell 
COLOR    Change colours of the CMD window 
COMP     Compare the contents of two files or sets of files 
COMPACT  Compress files or folders on an NTFS partition 
COMPRESS Compress individual files on an NTFS partition 
CON2PRT  Connect or disconnect a Printer 
CONVERT  Convert a FAT drive to NTFS. 
COPY     Copy one or more files to another location 
CSVDE    Import or Export Active Directory data  
 
DATE     Display or set the date 
Dcomcnfg DCOM Configuration Utility 
DEFRAG   Defragment hard drive 
DEL      Delete one or more files 
DELPROF  Delete NT user profiles 
DELTREE  Delete a folder and all subfolders 
DevCon   Device Manager Command Line Utility  
DIR      Display a list of files and folders 
DIRUSE   Display disk usage 
DISKCOMP Compare the contents of two floppy disks 
DISKCOPY Copy the contents of one floppy disk to another 
DNSSTAT  DNS Statistics 
DOSKEY   Edit command line, recall commands, and create macros 
DSADD    Add user (computer, group..) to active directory 
DSQUERY  List items in active directory 
DSMOD    Modify user (computer, group..) in active directory 
 
ECHO     Display message on screen 
ENDLOCAL End localisation of environment changes in a batch file 
ERASE    Delete one or more files 
EXIT     Quit the CMD shell 
EXPAND   Uncompress files 
EXTRACT  Uncompress CAB files 
 
FC       Compare two files 
FDISK    Disk Format and partition 
FIND     Search for a text string in a file 
FINDSTR  Search for strings in files 
FOR      Conditionally perform a command several times 
FORFILES Batch process multiple files 
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FORMAT   Format a disk 
FREEDISK Check free disk space (in bytes) 
FSUTIL   File and Volume utilities 
FTP      File Transfer Protocol 
FTYPE    Display or modify file types used in file extension associations 
 
GLOBAL   Display membership of global groups 
GOTO     Direct a batch program to jump to a labelled line 
 
HELP     Online Help 
HFNETCHK Network Security Hotfix Checker  
 
IF       Conditionally perform a command 
IFMEMBER Is the current user in an NT Workgroup 
INSTSRV  Install an NT Service 
IPCONFIG Configure IP 
 
KILL     Remove a program from memory 
 
LABEL    Edit a disk label 
LOCAL    Display membership of local groups 
LOGEVENT Write text to the NT event viewer. 
LOGOFF   Log a user off 
LOGTIME  Log the date and time in a file 
 
MAPISEND Send email from the command line 
MEM      Display memory usage 
MD       Create new folders 
MODE     Configure a system device 
MORE     Display output, one screen at a time 
MOUNTVOL Manage a volume mount point 
MOVE     Move files from one folder to another 
MOVEUSER Move a user from one domain to another 
MSG      Send a message 
MSIEXEC  Microsoft Windows Installer 
MSINFO   Windows NT diagnostics 
MUNGE    Find and Replace text within file(s) 
MV       Copy in-use files 
 
NET      Manage network resources 
NETDOM   Domain Manager 
NETSH    Configure network protocols 
NETSVC   Command-line Service Controller 
NBTSTAT  Display networking statistics (NetBIOS over TCP/IP) 
NETSTAT  Display networking statistics (TCP/IP) 
NOW      Display the current Date and Time  
NSLOOKUP Name server lookup 
NTBACKUP Backup folders to tape 
NTRIGHTS Edit user account rights 
 
PATH     Display or set a search path for executable files 
PATHPING IP trace utility 
PAUSE    Suspend processing of a batch file and display a message 
PERMS    Show permissions for a user 
PERFMON  Performance Monitor 
PING     Test a network connection 
POPD     Restore the previous value of the current directory saved by PUSHD 
PORTQRY  Display the status of ports and services 
PRINT    Print a text file 
PRNCNFG  Display, configure or rename a printer 
PRNMNGR  Add, delete, list printers set the default printer 
PROMPT   Change the command prompt 
PUSHD    Save and then change the current directory 
 
QGREP    Search file(s) for lines that match a given pattern. 
 
RASDIAL  Manage RAS connections 
RASPHONE Manage RAS connections 
RECOVER  Recover a damaged file from a defective disk. 
REG      Read, Set or Delete registry keys and values 
REGEDIT  Import or export registry settings 
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REGSVR32 Register or unregister a DLL 
REGINI   Change Registry Permissions 
REM      Record comments (remarks) in a batch file 
REN      Rename a file or files. 
REPLACE  Replace or update one file with another 
RD       Delete folder(s) 
RDISK    Create a Recovery Disk 
RMTSHARE Share a folder or a printer 
ROBOCOPY Robust File and Folder Copy 
ROUTE    Manipulate network routing tables 
RUNAS    Execute a program under a different user account 
RUNDLL32 Run a DLL command (add/remove print connections) 
 
SC       Service Control 
SCHTASKS Create or Edit Scheduled Tasks  
SCLIST   Display NT Services 
ScriptIt Control GUI applications 
SET      Display, set, or remove Windows NT environment variables 
SETLOCAL Begin localisation of environment changes in a batch file 
SETX     Set environment variables permanently  
SHARE    List or edit a file share or print share 
SHIFT    Shift the position of replaceable parameters in a batch file 
SHORTCUT Create a windows shortcut (.LNK file) 
SHOWGRPS List the NT Workgroups a user is in 
SHOWMBRS List the members of an NT Workgroup 
SHUTDOWN Shutdown the computer 
SHUTGUI  Shutdown the computer 
SLEEP    Wait for x seconds 
SOON     Schedule a command to run in the near future 
SORT     Sort input 
START    Start a separate window to run a specified program or command 
SU       Switch User 
SUBINACL Edit file and folder Permissions, Ownership and Domain 
SUBST    Associate a path with a drive letter 
 
TASKLIST List running applications and services 
TIME     Display or set the system time 
TIMEOUT  Delay processing of a batch file 
TITLE    Set the window title for a CMD.EXE session 
TOUCH    Change file timestamps     
TRACERT  Trace route to a remote host 
TREE     Graphical display of folder structure 
TYPE     Display the contents of a text file 
 
USRSTAT  List domain usernames and last login 
 
VER      Display version information 
VERIFY   Verify that files have been saved 
VOL      Display a disk label 
 
WHERE    Locate and display files in a directory tree 
WHOAMI   Output the current UserName and domain 
WINMSD   Windows NT Diagnostics 
WINMSDP  Windows NT Diagnostics II 
WMIC     WMI Command 
 
XCACLS   Change file permissions 
XCOPY    Copy files and folders 
 
 
Izvori: 
1. WindowsXP Professional Resource Kit 
www.microsoft.com/resources/documentation/windows/XP/all/reskit/en/us/  
2. Lisa Donald, James Chellis “MCSE: WindowsXP Professional Study Guide”, Sybex2002. 
3. Mark Minasi “WindowsXP Professional – do kraja”, Kompjuter biblioteka 2001. 
4. Robert Elsenpeter i Toby Welte “Windows XP Professional: administriranje mreža”, Mikro knjiga Zagreb 2004. 
5. http://www.elitesecurity.org
6. http://www.onecomputerguy.com
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